
Tutorial:  Creating a Basic Demographic Questionnaire 

The following tutorial will demonstrate how to create a very basic questionnaire using the 
AskAnywhere® Editor, including: 
 

1. entering and editing the text of your questionnaire, 
2.  creating various response sets (i.e. answer items for questions), 
3.  saving and testing the questionnaire. 

 
While this tutorial does focus primarily on single response item questions (questions that allow survey 
respondents to select only one response), other tutorials cover more complex response items such as 
multiple response items, analog rating scales, and masked item responses, for instance. 
 
This tutorial assumes that by now you are comfortable locating and opening the AskAnywhere® Editor 
program on your computer.  However, should you need to review how to access and open the program 
please return to the index to see either the Quickstart guide or the “Getting Started Section” of the full 
manual (both of which are available in either HTML or PDF formats). 
 
For the purposes of this tutorial, we will pretend that you a member of a marketing research firm and you 
have been given the task of generating basic demographic questions for a survey. The survey, to be 
created in AskAnywhere® should include questions such as the following: 
 

� What is your gender? 
� What is your age? 
� What is your marital status? 
� How many people, including yourself, are there in your household? 
� What is the highest level of education you have completed? 
� What is your employment status?  
� What is your household’s total annual income for the most recent calendar year? 

Creating the Questionnaire 

Launch the editor program by double clicking its icon.  When the editor opens, it will open to a new, 
blank survey page.  (See the figure below.) 
 

Note:  To improve readability, the editor window pictured below has been 
reduced in size; your default window size is larger than that shown in the 
tutorials. 
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Blank, Untitled Questionnaire 

Note:  The default language for the AskAnywhere® Editor program is English.  
If you wish to select another language, click on the Language menu when the 
editor program first launches a new survey.  You must set the language before 
you begin using other features of the Editor.  Once you begin using the editor, 
the Language menu will no longer be active. 

 
To begin entering a question, first, click on the Add Question to Page button located in the main toolbar. 
(See the figure below.)   
 
 

 
Add Question to Page Button 

When the Question Editing window opens, type in the text for the first demographic question  (See the 
figure below.): 
 
  What is your gender? 
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Question Editing Window Displaying Question Text 

Note:  The default font for questions is Serif, while the default text size is 18 
points and the default color is black.  At this point, you may change the font, 
size, and color of the text of your question clicking on the “Font”, “Size,” and 
“Color” options in the Question Editing window.  Additionally, you may set the 
justification of your questions by clicking on the “Just” pull-down menu.  The 
default justification is left. 

 
After typing the text of the question, click Apply to apply the changes you have made and to leave the 
Question Editing window open, or click Ok to apply the changes and close the window. 
 
You now want to add the response items for this first question.  So, click on the Add Answer to Page 
button located in the main toolbar.  (See the figure below.) 
 
 

 
Add Answer to Page Button 

The Answer Editing window, which features all the tools you will need to create response items for each 
question, will open.  (See the figure below.) 
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Answer Editing Window 

For this first question, you want to create a simple checklist of two items.  You don’t need to make any 
changes to the answer type, since the default answer type is a “Check List”.  (See the “Button & Answer 
Types” section of the figure above.) 
 
Enter the text for the answer items by typing “male” and “female” on separate lines under the heading 
“Item Text”.  (See the figure below.  Please Note:  To aid in readability, many of the figures throughout 
this section will display only a portion of the Answer Editing window.) 
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Entering Answer Item Text 

To select the button type for the check list, go to the Button pull-down menu in the “Button and Answer 
Types” section in the middle right portion of the Answer Editing window.  Scroll down to select round 
buttons.  (See the figure below.)  
 
 

 
Selecting Button Type 

To create a variable name, type “gender” in the open text box next to the heading “Name” in the 
“Variable” section near the top left of the Answer Editing window.  Then, type the words “Respondent’s 
Gender” in the open text box next to the heading “Label.”  (See the figure below.) 
 
 

 
Setting Variable Name and Label 

Note:  You may click on the word label to open a larger text box in which you 
can type the label for your variable.  Labels can be as descriptive as you wish. 

 
At this point, you may also want to set the text font, size, and color for the answers in this response set.  
Use the pull-down menus in the “Text” section of the Answer Editing window. To bold or italicize the 
answer item text font, click in the appropriate boxes beside B and I.  (See the figure below.) 
 

Note:  The default Text settings are 18 point, black, Serif font. 
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Setting Answer Text Font Style, Size, Color, and Format 

Once you have made all your changes, click Ok. 
 
The questionnaire page that you just created should look similar to the one pictured below.  Note, 
however, that the font for the answer items has been change to “Tahoma” rather than the default font of 
“Serif”. 
 
 

 
Page One of Questionnaire with Question and Answer Set 

You are now ready to add the next page to the questionnaire so that you can continue entering questions 
and response sets. To add the next page to the questionnaire, click on the Append Blank Page button in 
the main toolbar.  (See the figure below.) 
 
 

 
Append Blank Page Button 

Note:  When you click on the Append Blank Page button to add a page to a 
survey, the new page will always be added to the end of the survey. 
 

Open the Question Editing window and type the following text for your next question: 
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Please enter your age on your last birthday. 

 
Click Ok when finished typing the text. 
 
For the response item for this question, you want respondents to enter a number that represents their age 
on their last birthday.  Hold down the Ctrl key when clicking on the Add Answer to Page button, to 
open a modified version of the Answer Editing window  (See the figure below.) 
 
 

 
Modified Answer Editing Window 

Click in the first cell under the column heading “Type”.  Next, click on the Type pull-down menu, scroll 
down, and select Integer.  (See the figure below.) 
 
 

 7 



 
Selecting Integer 

 
Note:  You want to select Integer rather than Real because selecting Integer 
means respondents must enter whole numbers.  Selecting Real would enable 
respondents to enter numbers containing decimal points  (i.e. 18.5). 
 

The following window will open and will prompt you to enter any lower and upper limits you wish to set.  
For this question, you may want to set the lower and upper limits to 18 and 110, respectively. 
 
 

 
Setting Integer Limits 

Click Ok. 
 
Next, you may want to create a “label” for the integer answers survey respondents will input.  First, click 
in the first cell under the heading “Type” that currently reads “Text” or is blank.  (This cell should be the 
cell that is immediately below the cell that now reads “Integer”.)  Then, click on the Type pull-down 
menu, scroll down and choose Label.  (See the figure below.) 
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Selecting Label 

After you have chosen Label, type the word “years” in the cell immediately to the right (under the 
column “Item Text”).  (See the figure below.) 
 
 

 
Entering Label Text 

Click Ok.  Your completed survey page should look similar to the one pictured below.   
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Sample Survey Page with an Integer Answer Item 

Note:  In the figure above, “Item 1” represents the answer survey respondents 
will input when the survey is open in their web browsers. 

 
Add the next page to your survey and then open the Question Editing window.  For the text of your next 
question, type the following: 
 

What is your marital status? 
 
Click Ok to close the Question Editing window, and then click on the Add Answer to Page button to 
open the Answer Editing window. 
 
For this response set, you are going to include “other” as an option that respondents may choose.  To 
include the other “option”, first, go to the “Button and Answer Types” section of the Answer Editing 
window, click on the A-Type pull-down menu, and change the answer type to Check List Open.  
Selecting Check List Open insures that respondents will see on empty text field whenever they select  
“Other” as a response.  (See the figure below.) 
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Selecting Check List Open 

Refer to the figure below and enter the text displayed in the open cells under the heading “Item Text.” 
 
 

 
Entering Text for “Other” Option Answer Item 

 
Click Ok.  Your survey page should look similar to the one pictured below. 
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Sample Survey Page with “Other” Option 

 
Add the next page to the survey by clicking on the Append Blank Page button in the main toolbar.   
 

Note:  You may add several pages to a survey at one time by going to the 
Utilities menu, and selecting Add Page(s)…  When you select Add Page(s)…, 
the following window, which prompts you to enter the number of pages you 
want to insert and the number of the page you want the pages inserted before. 
 

 
Add Pages Window 

 
When the new page is added, open the Question Editing window by clicking on the Add Question to 
Page button in the main toolbar, and then enter the following text in the text box: 
 
  How many people, including yourself, are in your household? 
 
Click Ok. 
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Next, open the Answer Editing window by clicking on the Append Blank Page button in the main 
toolbar.  For this response set, you are going to create a simple checklist of numbers for respondents to 
select from. 
 
Refer to the figure below, and enter the text displayed in the open cells under the heading “Item Text.” 
 
 

 
Entering Answer Item Text 

 
Click Ok.  Your completed survey page should look similar to the one pictured below. 
 
 

 
Sample Survey Page 
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Add another page to the survey, and then open the Question Editing window.  In the text box, type the 
following: 
 
  What is the highest level of education you have completed? 
 
Click Ok when you are finished typing and formatting the text of your question. 
 
Now, open the Answer Editing window.  For this response set, you will display the response items for 
this answer in a pop-up menu.  To select the pop-up menu option, click on the A-type pull-down menu in 
the “Button and Answer Types” section and select Pop-Up Menu.  (See the figure below.) 
 
 

 
Selecting Pop-Up Menu as Answer Type 

Refer to the figure below and enter the displayed text in the open cells under “Item Text.” 
 
 

 
Entering Answer Item Text 

Click Ok when finished entering your answer item text.  The survey page you just created should be 
similar to the one pictured below. 
 
 

 14 



 
Sample Survey Page With Pop-Up Menu 

 
Note:  In the AskAnywhere® Editor program, the pop-up menu does not 
function directly in the Editor itself.  You may examine how the pop-up menu 
functions by going to the Utilities menu and choosing the Test option.   

 
You may adjust the size of the pop-up menu by holding the Shift key while clicking and dragging on the 
arrow that represents the pop-up menu. 
 
Add an additional survey page by clicking on the Append Blank Page button.  Open the Question 
Editing window by clicking on the Add Question to Page button.  Type the following text for your next 
question: 
 
  What is the highest level of education you have completed? 
 
Click Ok when finished. 
 
Open the Answer Editing window by clicking on the Add Answer to Page button in the main tool bar.  
As with the previous, question, you are going to display your answers in a pop-up menu.  Select Pop-up 
Menu from the A-type pull-down menu in the “Buttons and Answer Types” section of the Answer 
Editing window.  Then, refer to the figure below and enter the displayed text in the cells under the 
heading “Item Text.” 
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Entering Answer Item Text 

Click Ok. 
 

Note:  Remember that you may need to adjust the size of the pop-up menu 
(answer) frame, so that the pop-up menu will clearly display all of the text for 
each answer item when survey respondents are viewing the survey.  A good 
gauge is to make your pop-up menu (answer) frame as long as or a bit longer 
than the length of the longest answer item in your response set. 

 
Because the final question of your survey is related to the previous question, you will put the final 
question on the same page as the question you just completed.  Click on the Add Question to Page 
button to once again open the Question Editing window.  Enter the following text: 
 
  What was your household’s total annual income for the most recent calendar year? 
 
Click Ok when finished. 
 
Like the figure below, you should now have two question frames on one survey page. 
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Two Question Frames on One Survey Page 

 
Note:  You may need to reposition the second question frame so that it is not on top of 
the first question frame or the answer frame.  Further, you want to reposition and resize 
the first question and answer frame so that all the frames are easily accessible on one 
page. 

 
Now, you want to add your second response set.  Click on the Add Answer to Page button in the main 
toolbar to open the Answer Editing window.  Your response set will be a checklist that gives respondents 
a range of salaries to choose from for each answer.   
 
Refer to the figure below and enter the displayed text in the open cells under the heading “Item Text.” 
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Entering Answer Item Text for Second Response Set 

Click Ok when finished entering text. 
 
You should now have a page displaying two question frames and two answer frames.  You may arrange 
the question frames and answer frames on the page as you choose.  The figure below displays one way the 
question and answer frames may be displayed. 
 
 

 
Sample Survey Page with Two Questions and Response Sets 

 
You have now completed the basic demographic questionnaire.  The next section of this tutorial will walk 
you through saving the questionnaire. 
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Saving the Questionnaire 

To save a new, untitled questionnaire, go to File menu and choose Save As… or Save.  (See the figure 
below.) 
 

 

Selecting Save As… From the File Menu 

The Save File As…window, pictured below, will open.   
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Save File As Window 

Select the location on your hard drive that you wish to save the file in.  Name the file and click Save. 
 
To save any changes to a previously saved and named file, go to the File menu and select Save or press 
Ctrl + S. 
 

Note:  If you attempt to close a survey you are working on by clicking on the X in 
the upper right corner and you have not saved your work, then a window in 
AskAnywhere® Editor will open and prompt you to either save and close your 
work, close without saving, or cancel.  (See the figure below.) 
 
 

 
AskAnywhere® Save Prompt Window 

You have now named and saved your questionnaire.  You may, at this point, want to test the 
questionnaire to see how the questionnaire functions for respondents.  The next section of this tutorial will 
walk you through the steps necessary to test a questionnaire. 

Testing the Questionnaire 

You may quickly test a questionnaire to see how it will look and perform for respondents as well as how 
the AskAnywhere® records the survey data it collects.  To test a questionnaire, first make sure you have 
saved any changes you have made to the questionnaire.  Then, go to the Utilities menu and select Test or 
press Ctrl + B.  (See the figure below.) 
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Selecting the Test Option 

 
The AskAnywhere® Editor will open a Test window in which you can test the questionnaire. (See the 
figure below.) 
 
 

 21 



 
Test Window 

 
Click through the survey by responding to questions to observe the way it operates. The test is designed 
so that you may repeat the entire survey.  Once you have gone through the entire survey in the test mode, 
a window will open telling you that the questionnaire has been completed.  (See the figure below.) 
 
 

 
Completed Questionnaire Prompt 

 
 
Clicking Ok will take you back to the first page of the questionnaire. 
 
To close the questionnaire, go to the File menu in the Test window and chose Close. 
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You may view the survey data collected during the test.  To view the data collected during the test, first 
go to the location on your computer’s hard drive where the AskAnywhere® Editor program was installed.  
On PCs, this location is typically, the AskAnywhere folder within the Program Files folder (i.e.  
C:\Program Files\AskAnywhere).  Survey data files are saved as .data files.  To locate the data collected 
during the test of a particular survey, locate the .data file with the same name as your survey.  For 
instance, to locate the data file for the survey we have created in this tutorial, you would find the file 
named demographic.data.  (See the figure below.) 
 
 

 
Locating a Data File 

To open the file, demographic.data, simply double click on the file.  The collected data will be displayed 
in a text file similar to the figure below. 
 
 

 
Data Collected in Test Mode 

Note:  On a PC, .data files will typically open in Notepad; on a Mac, .data files 
will typically open in SimpleText. 
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